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Getting Started  

Before using e-VU Express (Retrieve), please take the time to read through this guide and 

familiarise yourself with the controls and features available to you.  The guide itself is 

structured so that it can be read from beginning to end or as a quick reference for specific 

actions/features.   

 

LŦ ȅƻǳ ƘŀǾŜƴΩǘ ŀƭǊŜŀŘȅ ƛƴǎǘŀƭƭŜŘ e-VU Express, or you are having difficulties installing e-VU 
ExpressΣ ǇƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ǘƘŜ ΨŜ-±¦ 9ȄǇǊŜǎǎ оΦр Lƴǎǘŀƭƭŀǘƛƻƴ DǳƛŘŜΩ ŦƻǊ ŘŜǘŀƛƭǎ ƻn how to 
install the software.  If you are still having trouble installing the software, please refer to 
the Notices chapter on ways to contact Intelligent Filing for further assistance. 

 

No specialist knowledge is required to use e-VU Express (Retrieve) as all features and functions 

are covered in detail within this documentation, you will need at least a basic understanding 

of the Microsoft Windows desktop operating system to be able to use the software to its 

fullest. 

About e-VU Express 

The e-VU Express software is a document archive creation program, designed and developed 

by Intelligent Filing.  The purpose of the software is to provide a low cost, feature rich solution 

to the problems associated with archiving paper documents, which is also suitable for all sizes 

of business from sole trader to large enterprises. 

 

Based on the award winning e-VU Professional software, e-VU Express has at its centre, the 

basic building blocks of a document management system.  By using only the core principles of 

scan, store and retrieve, e-VU Express is an effective archiving utility which allows the 

archiving of documents to CD, DVD and flash drives.   

 

This effective tool can be used to help reduce the unnecessary clutter caused by storing 

historical paper records.  Where documents have to be retained (legal, medical etc) it can be 

ǳǎŜŘ ǘƻ ŎǊŜŀǘŜ άƭƻŎŀƭέ ŜƭŜŎǘǊƻƴƛŎ ŎƻǇƛŜǎ ƻŦ ǘƘƻǎŜ ŘƻŎǳƳŜƴǘǎΣ ǿƘƛƭŜ ǘƘŜ ƻǊƛƎinal documents can 

be put into document storage ς freeing up space and ensuring easier, faster access to the 

records in the event of an enquiry. 

e-VU Express Programs 

The e-VU Express software actually comprises of two programs, Capture and Retrieve; this 

documentation is specifically for the Retrieve program. 

 

 

http://www.intelligentfiling.com/products/software/evu_document_management/
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e-VU Express (Retrieve) 

The retrieve program is a lightweight, easy to use tool for searching your e-VU Express 

archives.  Unlike the capture program, there is no shortcut in the start menu for the retrieve 

program, as it is used directly from the CD/DVD or flash device where the archive is created.   

Software Licensing  

e-VU Express (Capture) is installed with a 10 day evaluation license.  During this time, you may 

use the program as much as you wish, without any restrictions.  After this time, you must 

either purchase a license key from Intelligent Filing, or uninstall the program.  Software 

licensing within e-VU Express is as straight forward as the program itself, you purchase a 

license for each workstation that you wish to install the software on and any additional 

ǎǳǇǇƻǊǘκƳŀƛƴǘŜƴŀƴŎŜ ƻǇǘƛƻƴǎ ŀƴŘ ǘƘŀǘΩǎ ƛǘ.   

 

Archives created during the evaluation period are yours to keep and use unrestricted, even 

after the evaluation period for the main program has expired. 

 

Check http://www.intelligentfiling.com/  for the most up to date license costs including any 
special offers.  Registered charities are entitled to the software for free; check the web site 
for terms and conditions. 

 

Starting e-VU Express 

How you start e-VU Express (Retrieve) does depend on where you created your archive.  If you 

created you archives on CD or DVD and you have the autoplay feature enabled on your 

desktop computer, e-VU Express (Retrieve) will automatically start, and you can jump right in 

and select the batches you wish to view. 

 

LŦ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ autoplay ŜƴŀōƭŜŘ ƻǊ ȅƻǳ ŎǊŜŀǘŜŘ ȅƻǳǊ ŀǊŎƘƛǾŜ ƻƴ ŀ ŦƭŀǎƘ ŘǊƛǾŜΣ ȅƻǳΩƭƭ ƴŜŜŘ ǘƻ 

find the program yourself using windows explorer.  To do this: 

 

1. Click Start 

2. Select the All Programs menu item 

3. Select the Accessories menu item 

4. Click Windows Explorer 

5. Browse to the drive letter under (My) Computer which corresponds to the device 

which holds your archive (D:\  for example) 

6. From the list of files, double click Express Search and e-VU Express (Retrieve) will 

spring into life 

 

http://www.intelligentfiling.com/
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Selecting Batches 

We know that businesses have a continual stream of documents waiting to be archived; lots of 

these will be the same category such as utility bills, and creating single archive on a CD for say 

WǳƴŜ лу ¦ǘƛƭƛǘȅ .ƛƭƭǎ ƛǎ ƴƻǘ ƻƴƭȅ ŀ ǿŀǎǘŜ ƻŦ ŀ /5Σ ōǳǘ ƛǘΩǎ Ƨǳǎǘ ŀŘŘƛƴƎ ƳƻǊŜ ǿƻǊƪ ǘƻ ǘƘŜ ŀǊŎƘƛǾŜ 

ǇǊƻŎŜǎǎ ōŜŎŀǳǎŜ ȅƻǳΩŘ ƘŀǾŜ ǘƻ ƪŜŜǇ ƭƻǘǎ ƻŦ ŘƛǎŎǎ ƘŀƴŘȅ ŦƻǊ ǎŜŀǊŎƘƛƴƎ ȅƻǳǊ ǊŜŎƻǊŘǎ ς in that 

sŎŜƴŀǊƛƻΣ ƛǘ ǿƻǳƭŘ ōŜ ŜŀǎƛŜǊ ǘƻ ƪŜŜǇ ǘƘŜ ǇŀǇŜǊ όǘƘŀǘ ŘƻŜǎƴΩǘ ŜǾŜƴ ōŀǊŜ ǘƘƛƴƪƛƴƎ ŀōƻǳǘΗύΦ 

 

²ŜƭƭΣ ǿŜΩǾŜ ǘƘƻǳƎƘǘ ǘƘƛǎ ǘƘǊƻǳƎƘ ƭƻƴƎ ŀƴŘ ƘŀǊŘΣ ŀƴŘ ǿŜ ŀŘŘŜŘ ǎƻƳŜ ōǊŀƛƴǎ ǘƻ e-VU Express 

(Capture) so that when you archive your batches off to the same re-writable destination and 

you come to view them, e-VU Express (Retrieve) knows all about the different batches! 

 

What happens when you start e-VU Express (Retrieve), the Batch Manager ƘŀǇǇŜƴǎΣ ǘƘŀǘΩǎ 

what.  Below is a step by step walk through of the Batch Manager in action: 

 

1. When e-VU Express (Retrieve) starts, the Batch Manager screen appears 

 

 
 

2. The default option is load all batches from the archive, simply click OK to do this and 

everything from the archive will be displayed on the screen.  If you un-tick the option 

ά[ƻŀŘ !ƭƭ .ŀǘŎƘŜǎέ ǘƘƻǳƎƘΣ ȅƻǳ ŀǊŜ ŀōƭŜ ǘƻ ǎŜƭŜŎǘ ŀƴȅ ōŀǘŎƘŜǎ ȅƻǳ ǿƛǎƘΣ ŦǊƻƳ ƻƴŜ ǘƻ ŀƭƭ 
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3. Select the batches that you wish to view and click OK to start e-VU Express (Retrieve) 

 

 
 

4. ¸ƻǳΩƭƭ ƪƴƻǿ ǘƘŀǘ ȅƻǳΩǊŜ ƻƴly viewing a selection of the available batches, because an 

information icon will be showing in the lower right corner of the program window 
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5. LŦ ȅƻǳ ŎƭƛŎƪ ǘƘŜ ƛƴŦƻǊƳŀǘƛƻƴ ƛŎƻƴΣ ȅƻǳΩƭƭ ǎŜŜ ŜȄŀŎǘƭȅ Ƙƻǿ Ƴŀƴȅ ōŀǘŎƘŜǎ ȅƻǳ ǎŜƭŜŎǘŜŘ ǘƻ 

view and how many batches there were in total 

 

 
 

Re-selecting Batches 

If you need to expand or reduce the items you are working with, you can quickly access the 

Batch Manager from the File menu.  To do this:  

 

1. From the File menu, click Select Batches 

 

 
 

2. bƻǿ ȅƻǳΩƭƭ ǎŜŜ ǘƘŜ Batch Manager, just as you did when you first started e-VU Express 

όwŜǘǊƛŜǾŜύΦ  !ƴŘΣ Ƨǳǎǘ ƭƛƪŜ ǿƘŜƴ ȅƻǳ ǎǘŀǊǘŜŘ ǘƘŜ ǇǊƻƎǊŀƳΣ ȅƻǳΩǊŜ ŦǊŜŜ ǘƻ ǎŜƭŜŎǘ ǿƘƛŎƘ 

batches you wish to view, from one batch to all batches 
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Now, if this is your first time using e-VU Express (Retrieve)Σ ȅƻǳΩƭƭ Ƴƻǎǘ ǇǊƻōŀōƭȅ ǿŀƴǘ ǘƻ 

explore the program to find out what all the buttons and things are for. 
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Exploring the Program  

!ŦǘŜǊ ȅƻǳΩǾŜ ǎŜƭŜŎǘŜŘ ȅƻǳǊ ōŀǘŎƘŜǎ ŀƴŘ ǘƘŜ e-VU Express (Retrieve) program begins, youΩƭl be 

presented with the initial program window (shown below).  The programs features are 

grouped in three distinct areas, the main menu, the search list and the document viewer. 

 

 

The Main  Menu 

File Menu 

The File menu consists of only two items.  The first of these, Select Batches allows you to 

ŀŎŎŜǎǎ ǘƘŜ .ŀǘŎƘ aŀƴŀƎŜǊ ǿƘƛƭŜ ǘƘŜ ǇǊƻƎǊŀƳ ƛǎ ōŜƛƴƎ ǳǎŜŘΦ  ¸ƻǳΩƭƭ ŦƛƴŘ ŀƭƭ ǘƘŜ ƛƴŦƻǊƳŀǘƛƻƴ ȅƻǳ 

need on this feature in Selecting Batches.  The remaining item is ExitΣ ŀƴŘ ŀǎ ȅƻǳΩǾŜ ƴƻ Řƻǳōǘ 

guessed, this closes down e-VU Express (Retrieve). 

Help Menu 

The Help menu is home to four menu items all related to helping you, the end user, get the 

moǎǘ ŦǊƻƳ ǘƘŜ ǇǊƻƎǊŀƳ ŀƴŘ ǇƻƛƴǘƛƴƎ ȅƻǳ ƛƴ ǘƘŜ Ƴƻǎǘ ŘƛǊŜŎǘ ǊƻǳǘŜ ǘƻ ǘƘŜ ŀƴǎǿŜǊǎ ǿƘŜƴ ȅƻǳΩǊŜ 

not.  The first menu item e-VU Express Help is the in-program link to this document, with a 

couple of clicks you can easily find the help you need, especially useful when you have one of 

ǘƘƻǎŜ άōƭŀƴƪέ ƳƻƳŜƴǘǎΦ  ¢ƘŜ ǎŜŎƻƴŘ ƛǘŜƳ ƛƴ ǘƘƛǎ ƳŜƴǳ ƛǎ e-VU Express Online.  Clicking this 

item will start your default web browser and (internet connection permitting) take you to the 

e-VU Express home page on www.intelligentfiling.com.   

 

http://www.intelligentfiling.com/


 

 

10 e-VU Express (Retrieve) 3.5 

User Guide - Page 10 of 19 

 

{ƻƳŜǘƛƳŜǎΣ ƛǘΩǎ Ƨǳǎǘ ŜŀǎƛŜǊ ǘƻ ŀǎƪ ǎƻƳŜƻƴŜ Ƙƻǿ ȅƻǳ Řƻ something or how to overcome a 

problem, and although we try and keep our documentation and FAQ up to date, sometimes 

the answers to some problems wonΩǘ ŀƭǿŀȅǎ ōŜ ǘƘŜǊŜ όƧǳǎǘ ȅŜǘύΦ  bŜǾŜǊ ŦŜŀǊΣ ƻǳǊ ǎǳǇǇƻǊǘ Ǝǳȅǎ 

are here and by clicking the Contact Support ƭƛƴƪΣ ȅƻǳΩƭƭ ǎŜŜ ŀ ƴŜǿ ŜƳŀƛƭ ǿƛǘƘ ǘƘŜ ŀŘŘǊŜǎǎ 

details already pre-ǇƻǇǳƭŀǘŜŘΦ  ¢ȅǇŜ ȅƻǳǊ ǉǳŜǊȅ ƻǊ ǉǳŜǎǘƛƻƴΣ Ƙƛǘ ǎŜƴŘ ŀƴŘ ǿŜΩƭƭ ƎŜǘ ōŀŎƪ ǘƻ ȅƻǳ 

ASAP. 

 

For evaluation users, our target time for initial response is 24 hours, but during busy 
periods, this can take up to 48 hours.  For our licensed customers with support and 
maintenance packages, your support level agreements are detailed in your contract. 

 

And finally from the Help menu; the obligatory About item.  Clicking this item displays the 

About screen (shown below).  The information contained on the first tab can be helpful to our 

ǎǳǇǇƻǊǘ Ǝǳȅǎ ƛŦ ȅƻǳ ƴŜŜŘ ǘƘŜƛǊ ƘŜƭǇ ŘƛŀƎƴƻǎƛƴƎ ŀ ǇǊƻōƭŜƳΣ ƛǘΩǎ ƴƻǘ Ŝŀǎy getting at this 

ƛƴŦƻǊƳŀǘƛƻƴ ƴƻǊƳŀƭƭȅΣ ǎƻ ǿŜΩǾŜ Ǉǳǘ ƛǘ ƘŜǊŜ ŦƻǊ ȅƻǳǊ ōŜƴŜŦƛǘΦ  hƴ ǘƘŜ About screen, you can 

also find the e-VU Express license agreement, should you need to refer to it, and Intelligent 

CƛƭƛƴƎΩǎ ŎƻƴǘŀŎǘ ƛƴŦƻǊƳŀǘƛƻƴ ŦƻǊ ǉǳƛŎƪ ǊŜŦŜǊŜƴŎŜΦ 

 

 
 

The Search List 

The search list is the area immediately below the main menu, to the left of the screen.  The 

search list comprises of the handy free text search field at the top, and the thumbnail versions 

of your documents at the bottom (see below). 
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CƻǊ ƴƻǿΣ ǘƘŀǘΩǎ ŀƭƭ ǿŜΩƭƭ ǘƻǳŎƘ ƻƴ ŦƻǊ ǘƘŜ ǎŜŀǊŎƘ ƭƛǎǘ ŀǎ ǿŜΩƭƭ ŎƻƳŜ ōŀŎƪ ǘƻ ƛǘ ǉǳƛǘŜ ŀ ōƛǘ ƳƻǊŜ ƛƴ 

the latter part of this guide. 

The Document Viewer  

The document viewer allows you to see what you have captured (from either scanning or 

importing documents or even a combination of the two) through its extra large main window 

and, when you capture many pages, you will also see thumbnails for all of the pages, allowing 

you to jump to a specific page quickly.  The document viewer (showing a multipage document) 

is shown below. 
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In addition to the thumbnails, the document viewer also provides a whole host of tools from 

simple navigation to page rotation, printing, copying and emailing your documents, helping 

you to get the most from your information.  These tools are explained below.  

Document Viewer Toolbar 

Page Navigation 

From the document viewer toolbar, you are able to move through multi-page documents a 

page at a time, view the page count for the document and the current page being viewed.   

 

 
 

Page and Document Rotation 

You can also perform clockwise and counter-clockwise rotation of the current document on a 

page by page or whole document basis. 

 

 
By pressing and holding the downward facing arrows of the rotation buttons, it is possible to 

rotate all pages in the current batch. 
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Display Size 

It is possible to alter how the page you are viewing is displayed on the screen by utilising the 

Zoom Presets.  By selecting the different items from this list, the displayed image will either 

grow or shrink.   

 

 
 

The three buttons which immediately follow the Zoom Presets are Zoom, Pan and Selection 

respectively and they are also used to alter how the document is displayed.  Zoom makes it 

possible to zoom into and out of a document using the left and right mouse buttons.  When 

selected, Pan allows documents to be dragged around so that portions of the document not 

being displayed can be visible.  Finally Selection allows the placement of a rectangular marker 

on the screen.  On releasing the mouse button, the preview window will zoom into the screen 

where the marker was drawn. 

 

Zoom, Pan and Selection are selectable and must be turned on and off.  Turning on one of 
the features automatically turns off a feature that was selected previous.  To return a 
document preview to its original size, select Best Fit from the Zoom Presets. 

 

Export Functions 

Being able to locate your documents quickly and easily is all well and good, but you may find 

ŀǘ ǘƛƳŜǎ ǘƘŀǘ ȅƻǳ ƴŜŜŘ ǘƻ ǎƘŀǊŜ ǘƘŜ ƛƴŦƻǊƳŀǘƛƻƴ ǿƛǘƘ ǇŜƻǇƭŜ ǿƘƻ ŘƻƴΩǘ ƘŀǾŜ ŀccess to e-VU 

Express (Retrieve).  The remaining items of the preview toolbar cater for this exact problem.  

These items allow you to copy the currently selected document to the clipboard, print the 

document or attach the document to a new email. 
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The first time you try and use the email feature of the program, you will be prompted to 

install the email plugin.  This is necessary in order to allow the program to create a new email 

message with the document attached.  The email plugin is installed as follows: 

 

1. Click the email button  

 

 
 

2. When the confirmation screen appears, click Yes to install the plugin 

 

 
 

3. When the plugin installation program starts, click Next 
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4. Click Install to begin the plugin installation 

 

 
 

5. Click Finish to complete the plugin installation 
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6. Click the email button again to create a new email message with your selected 

document already attached to the email 

 

 
 

 

Although every care has been taken to ensure compatibility with major email clients in 
some instances it will not be possible to attach the selected document directly to a new 
email message and you will receive an error message.  If this problem occurs frequently, 
consider using the copy and paste method of attaching a file to a new email message.   
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Retrieving Your Documents 

Its all well and good describing the features of the program in great detail, but we all know 

ǿƘŀǘΩǎ ǊŜŀƭƭȅ ƴŜŜŘŜŘ ƛǎ ǎǘŜǇ ōȅ ǎǘŜǇ ƛƴǎǘǊǳŎǘƛƻƴǎ ƻƴ Ƙƻǿ ǘƻ ǳǎŜ ŀƭƭ ǘƘƛǎ ƴƛŎŜ ǘŜŎƘƴƻƭƻƎȅ ǘƻ 

make retrieving individual documents a breeze. 

 

ΨtǊƻŎŜǎǎ ƻŦ ŜƭƛƳƛƴŀǘƛƻƴΩ ƛǎ ǘƘŜ ōŜǎǘ ǿŀȅ ǘƻ ǘƘƛƴƪ ƻŦ ǘƘŜ ǇǊƻƎǊŀƳ ǿƻǊƪƛƴƎΤ ǿƘŜƴ ȅƻǳ ǳǎŜ ǘƘŜ 

batch manager ǘƻ ǎŜƭŜŎǘ ƻƴƭȅ ǎǇŜŎƛŦƛŎ ōŀǘŎƘŜǎ ŦǊƻƳ ȅƻǳǊ ŀǊŎƘƛǾŜǎΣ ȅƻǳΩǊŜ ǇǊƻǾƛŘƛƴƎ ǘƘŜ 

program with enoǳƎƘ ƛƴŦƻǊƳŀǘƛƻƴ ǎƻ ǘƘŀǘ ƛǘ Ŏŀƴ ŜƭƛƳƛƴŀǘŜ ǘƘŜ ŘƻŎǳƳŜƴǘǎ ȅƻǳ ǿƻƴΩǘ ōŜ 

needing.  When you enter a word or phrase into the search listΣ ȅƻǳΩǊŜ ǘŜƭƭƛƴƎ ǘƘŜ ǇǊƻƎǊŀƳ ǘƻ 

ƘƛŘŜ ŀƴȅ ŘƻŎǳƳŜƴǘǎ ŦǊƻƳ ȅƻǳǊ ǾƛŜǿΣ ǘƘŀǘ ŘƻƴΩǘ Ŏƻƴǘŀƛƴ ǘƘŜ ǿƻǊŘ ƻǊ ǇƘǊŀǎŜ ȅƻǳΩǊŜ ƭƻƻƪƛƴƎ ŦƻǊΦ  

 

To be able to search on words or phrases using e-VU Express (Retrieve), ΩCǳƭƭ tŀƎŜ h/wΩ 
must have been enabled when a batch was saved.   

 

!ŦǘŜǊ ȅƻǳΩǾŜ started e-VU Express (Retrieve) ŀƴŘ ȅƻǳΩǾŜ selected your batches, searching for 

words or phrases can be accomplished in two easy steps: 

 

1. Enter your word or phrase into the box at the top of the search list 

 

 
 

2. Click the Search button and e-VU Express (Retrieve) will do the rest (you can also 

press the enter key straight after typing if you want to be really fast)  

 

 
 

 

!ƴŘΣ ǘƘŀǘΩǎ ŀƭƭ ǘƘŜǊŜ ƛǎ ǘƻ ƛǘΦ  ¢ƘŜ ǎǘŀǘǳǎ ōŀǊ ŀǘ ǘƘŜ ōƻǘǘƻƳ ƻŦ ǘƘŜ ǎŎǊŜŜƴ ǿƛƭƭ ǎƘƻǿ ȅou when 

ȅƻǳΩǊŜ ǾƛŜǿƛƴƎ ǘƘŜ ǊŜǎǳƭǘǎ ƻŦ ŀ ǎŜŀǊŎƘ όǎƘƻǿƴ ōŜƭƻǿύΦ 
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You can quickly clear the search results by selecting the option from the search button (or for 

you power users, the shortcut key combination Ctrl + Space) 

 

 
 

If e-VU Express (Retrieve) cŀƴΩǘ ŦƛƴŘ ŀƴȅ ŘƻŎǳƳŜƴǘǎ ǘƘŀǘ ƳŀǘŎƘ ǘƘŜ ǿƻǊŘ ƻǊ phrase you 

ŜƴǘŜǊŜŘΣ ȅƻǳΩƭƭ see the window below, and when you click the OK button any previous results 

will be cleared. 

 

 



 

 

19 e-VU Express (Retrieve) 3.5 

User Guide - Page 19 of 19 

 

Notices 

Contents of this document are copyright ©2008 Intelligent Filing Limited 

 

Reproduction in part or full for use other than the normal operation of the software without 

the prior consent of Intelligent Filing Limited is expressly prohibited. 

 

Intelligent Filing Limited can be contacted in the following ways: 

 

1. By Post 
Intelligent Filing Limited 

Pembroke Centre 

Cheney Manor Estate 

Swindon 

Wiltshire 

SN2 2PQ 

 

2. By Email: 
support@intelligentfiling.com 

 

3. By Telephone: 
+44 (0) 1793 486 668 

 

4. By Fax: 
+44 (0) 1793 610 091 
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